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Using GPS in Natural Resources: A Beginner’s 
Training 

November 2, 2011 
 
Instructor: Nevin Dawson, Forest Stewardship Educator 

In Cooperation with: Jonathan Kays, Natural Resources Extension Specialist, Elli 
Hammond, Forestry Extension Assistant, and John McGee, Virginia Geospatial 
Extension Specialist 

Agenda: 

9:00 Registration (Provide each participant a unit for workshop use and a training 
manual) 

9:30 Introduction to GPS (Classroom instruction) 

10:15 Getting the know the GPS receiver (Classroom instruction) 

10:30 Activities: Getting to Know the GPS Receiver (Field Exercise); Setting Up the 
GPS Unit (Field exercise); Waypoints, Routes, and Area (Field exercise); 
Entering Coordinates and Finding Locations (Inside activity); Mapping roads, 
boundaries and other features on timber sale. Creating waypoints using the 
mapping feature. (Field exercise) 

12:00 Lunch 

12:45 Mapping and GPS Software/Activity 5: (Classroom instruction) 

Download points from activities and work with software on computers. 

- USAPhotoMaps 
- Easy GPS 
- GPS Utility 
- Google Earth 
- MD Merlin 
- National Map Viewer 
- Terrain Navigator  (demonstration only) 

 

3:30 Close 
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     Picture 1          Picture 2

Picture 3 

Activity 1: Getting to Know the GPS Receiver 
 
Turn the unit on by holding down the Power button (red circle with vertical line) for 
two seconds. 
 
After the welcome screen, the Satellite screen will appear and it will briefly read 
“Acquiring Satellites” at the top. If you are out in the open, it should only take a short 
time to acquire enough satellites to make out your location.  
 
If the unit cannot get a satellite fix, an options menu with a list of solutions will 
appear (picture 1). Highlight the appropriate option and press ENTER.  
 
 
 
 
 
 
 
 
 
 
 
 
 
The large, outer circle represents the horizon; the inner circle is 45 degrees in from 
the horizon (picture 2). The gray and red circle on the outer circle represents your 
direction of travel. 

 
Which numbered satellite is most closely overhead? 
__________ 
 
How many satellites are being received by your GPS 
receiver? __________ 
 
What is the accuracy indicated by your receiver?  
+/-__________ 
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Picture 9 

Pressing the PAGE button will allow you to cycle through the following five screens: 
 
 

 
While on the Trip Computer screen (picture 5), what does it say is your 
elevation? __________ 

 
Go to the Map screen (picture 6). Zoom in and out using the IN and OUT buttons. 

 
When zoomed all the way out, what is the scale of the map? __________ 
When zoomed all the way in, what is the scale of the map? __________ 

 
Go to the Compass screen (picture 7) and walk around. Notice how your speed and 
direction change. 

 
What is your approximate rate of speed? __________ 

 
On the Main Menu screen (picture 8), use the rocker to highlight Sun & Moon; 
press ENTER.  

 
What time was sunrise this morning? __________ 

 
Use the rocker to highlight the play button (single right-
facing arrow) (picture 9). Press ENTER to view the 
movement of the sun and moon today. Highlight fast 
forward (double arrow) and press ENTER to view the 
changes in high speed. Watch how the phases of the moon 
change over time. 
 
On the Main Menu screen, use the rocker to highlight Hunt & Fish; press ENTER.  

 
What are the best times to hunt or fish today? ____________________ 

Compass Satellite Map Trip Computer Main Menu 

Picture 4                 Picture 5              Picture 6                  Picture 7             Picture 8   
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Picture 10           Picture 11 

 Picture 14

The Wide Area Augmentation System (WAAS) can be accessed to improve the 
integrity of the GPS signal (the system is called EGNOS in Europe).  

 Press MENU twice to get to the Main 
Menu. Highlight Setup and press 
ENTER.  

 Highlight System and press ENTER 
(picture 10).  

 Highlight the WAAS/EGNOS box and 
press ENTER (picture 11).  

 Highlight Enabled and press ENTER. 
Your unit will now pick up WAAS 
signals, if available. 

 
 
 
Press QUIT twice to go back to the Main Menu. (Or, from any screen, you can press 
the MENU button twice to return to the Main Menu screen.) 
 
 

If you would like to use your GPS unit to guide you 
while driving on highways, you will want the routing 
to guide you along roads, rather than as the crow 
flies.  

 Highlight Setup and press ENTER.  
 Highlight Routing and press ENTER 

(picture 12). 
 Highlight the Guidance Method box and 

choose Off Road since we will be walking 
off road today (picture13). 

 
 
 
The MENU button brings up different menus depending on the 
screen. You may want to experiment with this on your own to 
explore the many options on various screens. 
 
Press PAGE to get to the Trip Computer screen. Press MENU 
once (picture 14). 

What are your first two options? ____________________ 
 
 
 
If you do not wish to make changes, you can press the QUIT or MENU buttons to 
return to the previous screen or Main Menu.      

 Picture 12           Picture 13 
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Activity 2: Setting Up the GPS Unit 
 
Before going out to use your GPS unit in the field, you may want to change some of 
the settings. The following instructions are for changing the tracks, tone, on/off road, 
and compass settings. 
 
Tracks 
When tracks are on, a location data point is recorded intermittently, creating what 
look like breadcrumbs marking the path you have taken. Tracks can be set to record 
a “breadcrumb” at intervals based on time or distance. If you are traveling slowly or 
have stop along the way, you may want to record based on distance rather than 
time, so that there are not several breadcrumbs recorded for the same spot. 
 

 Press MENU twice to return to the Main Menu. 
 Highlight Tracks and press ENTER (picture 1). 
 Highlight Setup and press ENTER (picture 2). 
 Highlight Record Method and press ENTER (picture 3). 
 Highlight your selection and press ENTER. 

 
If you chose Distance or Time, you will be able to change the interval between 
recordings.  

 Highlight the Interval box and press ENTER. 
 A number pad screen will appear and you can specify the time or distance 

interval (picture 4). 
 
 
 
 
 
 
 
 
 
 
 
 
 
By checking the box labeled Wrap When Full, the GPS unit will record over old 
tracks when the memory assigned to tracks becomes full. If you do not want old 
tracks erased, un-check this box by pressing ENTER. 
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Tone Setup 
There are a variety of options for changing the tones produced by the GPS unit.  

 
 Press MENU twice to get to the Main Menu. 
 Highlight Setup and press ENTER. 
 Highlight Tones and press ENTER (picture 5). 
 Select which tone volume you would like to change and press ENTER 

(picture 6). The higher the tone number, the louder the beep. 
 If you would like to mute all tones, highlight Mute and press ENTER to check 

or un-check the box (picture 7). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
On/Off Road 
If you will be traveling through the woods, on trails, or on roads that are not mapped 
in your GPS unit, you will want it set to off road so that instructions are not given 
using roads. 
 

 Press MENU twice to get to the main menu. 
 Highlight Setup and press ENTER (picture 8). 
 Highlight Routing and press ENTER (picture 9). 
 Highlight the box under Guidance Method and press ENTER (picture 10). 

You will be given the choices Follow Road, Off Road, and Prompted.  
 Highlight Off Road and press ENTER (picture 11). 
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    Picture 12           Picture 13     Picture 14          Picture 15 

 
 
Compass Heading 
Most GPS units do not have an electronic compass, so the compass directions only 
work when you are moving. (Garmin units with an “S” in the name, such as the 
GPSmap 76CSx, do have an electronic compass.) You can change the compass 
settings based on true north, magnetic north, or a grid set to the degree variation 
you specify. 
 

 Press MENU twice to go to the Main Menu. 
 Highlight Setup and press ENTER. 
 Highlight Heading and press ENTER (picture 12). 
 Highlight the North Reference box and press ENTER. Select your preference 

and press ENTER (picture 13). 
 If you would like to specify the degree of magnetic variation, highlight User 

and press ENTER. Then, highlight the Magnetic Variation box and press 
ENTER (picture 14). A number pad screen will pop up. Enter the desired 
value, highlight and press ENTER (picture 15). 
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Activity 3: Waypoints, Routes, and Tracks 
 
PROJECT A: Waypoints 
Waypoints are pinpointed locations that are stored in a GPS unit. They are used to 
mark places or in creating routes. You can create waypoints on your GPS unit or on 
a computer and transfer them. 
 
Deleting Waypoints 
Before starting this activity, you may want to clear previous waypoints that have 
been saved on your GPS unit. 

 Press FIND.  Select Waypoints and press ENTER (picture 1).  
 If there are waypoints listed and you want to delete them all, press MENU and 

select Delete… (picture 2). 
 On the screen that appears, select All Symbols and press ENTER (picture 

3). 
 A box will now come up asking if you really want to delete all waypoints. 

Select Yes and press ENTER (picture 4). 
 
 

 
 
 
 
 
 
 

 
 
 
 

 If you only want to delete one waypoint, press FIND. Select Waypoints and 
press ENTER (picture 1).  

 Highlight the waypoint you want to delete and press ENTER (picture 5). 
 Highlight Delete and press ENTER (picture 6). 
 A box will now come up asking if you really want to delete the waypoint. 

Select Yes and press ENTER (picture 7). 
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Creating New Waypoints 
 Go to the Map screen. Zoom in all the way by pressing the IN button several 

times. Walk around. In the upper left corner of the screen, a compass arrow 
will point north (picture 8).  

 Stop somewhere and create a waypoint by pressing and holding ENTER until 
the screen changes to show the “Mark Waypoint” screen (picture 9). This 
screen allows you to change the name of the waypoint and shows information 
about it such as when it was created and the location.  

 Change the name of this waypoint by highlighting the name box at the top of 
the screen and pressing ENTER. Using the rocker and enter button, name 
this waypoint End. When you are finished, highlight OK on the letter/number 
screen and press ENTER (picture 10). 

 You can change the symbol for any waypoint by first highlighting the flag at 
the top of the screen (picture 11). Press ENTER and choose the red flag 
symbol from the Markers screen (picture 12). 

 Once you have chosen the symbol, highlight OK at the bottom of the screen 
and press ENTER. The new symbol will appear on the map where you 
created the waypoint. 

 Walk about 30 yards away and create another waypoint named Start. Give 
this waypoint a green flag symbol. Stay at this second waypoint and begin 
Project B. 

 
Averaging a Waypoint 
To obtain a more accurate location for your waypoint, you can have the GPS 
receiver take several measurements at the same location. It will then average these 
measurements to provide a better estimate for the coordinates for your specific 
location. 
 

 Create a waypoint for your current location by holding ENTER. 
 Highlight Avg (picture 13) and press ENTER. 
 A new screen will appear showing the waypoint information. At the 

bottom of this screen, you will see the Measurement Count number 
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increasing about every second (picture 14). The Estimated Accuracy 
number should decrease as more measurements are taken. 

 When you are satisfied with the estimated accuracy, highlight Save 
and press ENTER. This will save the averaged waypoint just like any 
other waypoint. 

 NOTE: Remain still as the GPS unit is taking measurements. You will 
have better accuracy if you are away from large objects like buildings 
or large trees, and if there is little or no overhead cover. 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
Application – You can use the waypoint function to mark and name roads, property 
boundaries, stream crossings, buffer areas, logging deck location, access points, 
tree locations (specimen trees), and high quality timber. Use the Average Waypoint 
function when you need a more accurate location and can remain at a marking 
location for a few seconds. 

    Picture 13              Picture 14
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  Picture 20         Picture 21

PROJECT B: Routes 
Use the Routes feature to obtain directions between waypoints you created. 
 

 Press MENU twice to return to the main menu page. Use the rocker button to 
highlight Routes and press ENTER. Highlight NEW on the bottom of the 
screen and press ENTER (picture 15). Press ENTER to “Select Next Point” 
(picture 16).  

 On the next screen, highlight the Waypoints icon and press ENTER (picture 
17). Using the rocker, highlight the waypoint marking your starting position 
(Start waypoint) and press ENTER (picture 18). On the Waypoint page that 
popped up, highlight Use and press ENTER (picture 19). 

 
 
Now your starting waypoint should be listed on the Route screen. 
 

 Again, highlight Select Next Point and 
press ENTER (picture 20). Highlight the 
Waypoints icon and press ENTER.  

 Now highlight the End waypoint, and 
press ENTER (picture 21). Highlight 
Use in the lower right hand corner of 
the screen and press ENTER.  

 
 
 
 
 
 
Now your two waypoints should be listed in the Routes page. 
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 Highlight Navigate and press ENTER 
(picture 22). The map screen will 
appear, showing your current location 
marked by a black arrow (picture 23). 
The top of the screen will instruct you 
which direction to travel. Refer to the 
North cardinal arrow to help orient 
yourself.  

 
 
 

 Follow the on-screen instructions, moving toward your destination. When you 
get within about 30 feet of the End waypoint, the unit will beep and read 
“Arriving at End.” 

 
 
When you are finished navigating, be sure to turn off navigation. If navigation is left 
on, you may have trouble using other functions of the GPS unit. Turning navigation 
off can be done several ways.  
 

 From the compass screen, press MENU. Select Stop Navigation and press 
ENTER (picture 24).  

 From the map screen, press MENU. Select Stop Navigation and press 
ENTER (picture 25). 

 From the routes screen, highlight Stop and press ENTER (picture 26). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Application – You can enter waypoints in a GPS unit and give it to coworkers, 
buyers, etc. to find their way to an access point or a corner of a timber sale. The 
waypoints for property corners or timber sale boundaries can be entered into a route 
so people can navigate around the perimeter. 
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Picture 27 

Picture 28

Project C: Finding Distance of a Perimeter and its Area Using the Tracks 
Option 
 
Use this function if you are walking/driving along the boundaries of location and want 
to find its area. 
 
 

 Go to the Main Menu page by pressing MENU twice. 
Highlight the Tracks icon and press ENTER. 

 Make sure Track Log is on by highlighting On and 
pressing ENTER (picture 27).  

 To clear any past tracks, highlight Clear and press 
ENTER. On the popup screen asking if you really 
want to clear the track, highlight Yes and press 
ENTER. 

 
 
 

 
 Now walk around the perimeter of the building. When you come back to your 

starting place, highlight Save and press ENTER. On the popup screen asking 
if you want to save the entire track, highlight Yes and press ENTER. 

 
Now the Saved Track screen will come up. It shows information about the track 
like the distance and area inside the track.  
 
 

 Highlight the Name and press ENTER to bring up the 
alphabet screen. Rename your track “Building.” 
Highlight OK and press ENTER (picture 28). 

 
What is the distance you traveled around the 
building? __________ 
 
What is the area of the space you walked around? 
__________ 
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Picture 32

There is another way to calculate the area of a property: 
 

 While on the Tracks page, press MENU. Highlight Area Calculation and 
press ENTER (picture 29). A map screen will appear with START highlighted 
at the bottom of the screen (picture 30). Press ENTER to begin tracking your 
movement.  

 Walk around, making a large circle or rectangle (about 100 or more paces), 
and when you get back to your starting point, highlight STOP on the tracking 
page and press ENTER.  

 
You should be able to see the shape you made as outlined by the tracks (dots on 
the map) (picture 31). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
At the bottom of your screen, you will see the area of the 
space you outlined. You can change the units by highlighting the 
units and pressing ENTER (picture 32). The options are 
square feet, (ft2), square yards (yd2), square meter (m2), acre 
(ac), hectare (ha), square kilometer (km2), square mile (mi2), 
and square nautical mile (nm2). 

 
What is the area of the space you walked in square  
yards? _________ 

 
 
 
 
 
 
 
 
Application – Quickly find the area of a timber sale by walking or driving along the 
boundary while using the area calculation function. 
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Activity 4: Entering Coordinates and 
Finding Locations 

 
See “Timber Sale Coordinates” handout for the coordinates used in this exercise.  
You will enter the coordinates in your GPS receiver, and then find this place outside. 
 
To enter latitude/longitude coordinates, you must first create a waypoint. This can be 
done anywhere – you don’t need a GPS signal. 
 

 Create a waypoint by holding down ENTER. Give the location a name by 
highlighting the upper box next to the blue flag and pressing ENTER (picture 
1). An on-screen keypad will pop up. Use the rocker to enter a name for your 
first point (highlight a letter and press ENTER after each letter/number 
selection). You may want to name the waypoints Corner 1, Corner 2, etc. 
When you are finished entering the name, highlight OK and press ENTER 
(picture 2). 
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 While still on the Waypoint screen, use the rocker to highlight Location and 
press ENTER (picture 3). Using the on-screen number pad, enter the Latitude 
and Longitude coordinates you were given for the first point (picture 4). 
Highlight OK and press ENTER.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Repeat these steps, creating a waypoint for each corner of the timber sale 
and for the road entry point – name this waypoint Road 1. 

 
 
Now make a route that will lead you around the boundaries of the timber sale.  
 

 Press MENU twice to go to the Main Menu screen.  
 Highlight Routes and press ENTER.  
 You want to create a new route, so highlight New and press ENTER (picture 

5).  
 You will now begin to select points along the route to help you navigate. 

Highlight Select Next Point and press ENTER (picture 6).  
 Since you have entered the points as waypoints, highlight Waypoint and 

press ENTER (picture 7). 
 Highlight the waypoint marking the first corner and press ENTER. The 

Waypoint screen will come up. Highlight Use and press ENTER (picture 8). 
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 Now you’ll need to choose the next waypoint. Highlight Select Next Point 
and press ENTER. Select the next corner waypoint. Continue selecting the 
remaining Waypoints as before to complete your route.  

 Your last waypoint should be the same as the first timber sale waypoint, so 
you’ll be led back to your starting place to complete the boundary. 

 
 
Now you will travel to the first corner of your route. You will need to obtain a GPS 
signal if you have not already. 
 

 Press FIND. Highlight Waypoints and press ENTER (picture 9). Highlight the 
waypoint that is the first location in your Route. Press ENTER. On the 
Waypoint screen that comes up, highlight Go To and press ENTER (picture 
10). The map screen will come up (picture 11). Follow the directions leading 
you to the proposed timber sale. 

 
 Press PAGE to go to the Compass screen (picture 12). The compass arrow 

will direct you in which way you should travel. If you are traveling in the 
correct direction, the “Dist to Next” number will decrease as you get nearer 
your destination. When you get close to your selected waypoint, your GPS 
unit will beep and the message “Arriving at ___” will appear (picture 8). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
You can follow the directions on the map or compass screens. Press PAGE to 
switch between views. Use whichever one you are more comfortable with. 
 

 When you reach the first waypoint and are ready to start your route, set up 
Tracks to mark your movement.  
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Tracks will allow you to find the distance of the perimeter and the area of the 
potential timber sale.  
  

 Press MENU twice to go to the 
Main Menu. Highlight Tracks and 
press ENTER. Make sure the 
Track Log is On (picture 13) and 
Clear the track log by selecting 
Clear and answering Yes on the 
popup screen (picture 14). 

 
 
 
Now begin navigating your way along your route. 
 

 Press MENU twice to go to the 
main menu screen. Highlight 
Routes and press ENTER. Select 
the route you created and press 
ENTER. Highlight Navigate and 
press ENTER (picture 15). The 
map screen will come up and 
directions will appear at the top of 
your screen (picture 16).  

 
 
 
You can view your progress on different screens. Press PAGE to go to the Map 
screen. Follow the purple line to your next waypoint. Press PAGE again to get to the 
Compass page. The red arrow will tell you which direction to travel. As you approach 
a waypoint, the unit will beep. Once you reach a waypoint, you will automatically be 
directed to the next waypoint. 
 
When you get back to your starting point, go to 
the Main Menu, then to the Tracks page and 
select Save and select Yes on the popup 
screen (picture 17). The Saved Track 
screen will come up providing information of 
the track you just traveled along your route 
(picture 18). 
 

What is the distance you traveled? 
__________ 
 
What is the area of the timber sale in acres? __________ 
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Go to the road entry point. Create a new waypoint here and name it Road 1.  
 

 Enter the woods at this waypoint and find the flagged cherry tree. Create a 
new waypoint there and name it Cherry. 

 
 
Application – You can provide coordinates for access points, key property corners, 
and other features on a timber sale bid so potential buyers or work crews can find 
and navigate the sale area more easily on their own. Mark points for a future logging 
road, harvest location, tree planting area, or spray location and give the GPS unit to 
the work crew to carry out needed tasks.  
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Activity 5: Creating Waypoints Using the 
Map Feature  

 
A) Create waypoints without going to the location or knowing the coordinates. 

 
 Go to the Map screen. Zoom in or out so that you can easily see the local 

roads.  
 Using the rocker, move the arrow to the location described by the instructor. 

Press ENTER. If there is no information known for that spot, a message will 
come up asking “Do you want to create a user waypoint here?” (picture 1) 
Highlight Yes and press ENTER. You have now created a new waypoint 
(picture 2).  

 If there is information about that spot saved in your GPS unit, a nametag will 
appear when your arrow is over it (picture 3). If you press ENTER to create a 
waypoint, it will automatically be named using the saved information (in this 
example, the point has been automatically named “Road”). You must select 
Save (picture 4) to keep it saved as a waypoint.  

 If you select Go To (picture 5), you will be given directions on the map screen 
to get there from your current location. If you choose Map (picture 6), the map 
screen will appear, showing the location of the new waypoint. 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Application: - Use this function when you want to create a waypoint for a place you 
can find on a map but don’t have its exact coordinates. 
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B)  Starting from a know point, follow an azimuth and distance to a new location 
and create a new waypoint.  

 
 To create waypoints on the GPS unit using azimuth and distance, you will 

need to have a starting waypoint saved in the unit or be at a known point. 
 
To create a waypoint a certain distance and 
bearing from a saved or newly created waypoint, 
first ensure that that the bearing you know is the 
same type as that used by the GPS unit, either 
magnetic or true.  The type of heading selected 
will be indicated on the GPS unit by a small letter 
under the degree sign (“m” or “t”). You can 
change this setting in the “Heading” submenu of 
the “Setup” menu.  
 
Now press FIND and select a starting waypoint. Once on the details screen for your 
selected waypoint, press MENU once. Select Project Waypoint and press ENTER. 
At the bottom of the screen, a box will be labeled “From …” naming the first waypoint 
you selected.  
 
By highlighting and pressing ENTER, you can change the bearing and distance. To 
change the distance units, highlight the current unit (miles (mi) is the default) and 
press ENTER. Once you enter the azimuth and distance, the latitude and longitude 
will automatically change to the correct coordinates for that location. Rename the 
waypoint and select Map. The new waypoint will be automatically saved. You can 
see the new waypoint on the map screen. 
 
When you are ready to create the next projected waypoint, press FIND, select the 
waypoint you just created, and proceed with the same process. This method allows 
you to make waypoints. If you want to make a route out of these waypoints, you can 
do that by creating a route and adding each point in order. 
 
Application – Going to a new location using the GPS map can be used to find the 
shortest route to a road, stream, building, or other location. If there is a medical 
emergency you can alert responders to the best access point and provide a latitude - 
longitude location.  
 
Following a distance and azimuth to a new waypoint is very useful for finding the 
boundaries of a property for which you have a survey. Most survey measurements 
are bearings so you will have to convert from bearing to azimuth (0-360 degrees).   
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USAPhotoMaps – Short Tutorial 
 
 

When you open the USAMaps program, a 
black and white aerial photo of the reflecting 
pool in Washington DC comes up. 
 
The Menu bar at the top of the screen has the 
following options: File, Zoom, GoTo, Zoom, 
Scroll, Text, Route, Waypoints, GPS, and 
Help. 
 
If you are viewing an area for the first time, 

there may be gray boxes instead of photos or topo maps. To download photo or 
map images, press F. Once downloaded, they are saved on your computer. 
To view topographic maps, press T, or click View on the menu bar. Select Map Type 
> Topographical Maps. 
To view black and white aerial photographs, press P. 
 
To connect a GPS unit, click GPS. On the 
dropdown menu, choose Baud. Select 9600. 
Then, on the GPS dropdown menu, choose 
Protocol. Select Garmin USB. You should 
now be able to transfer to and from the GPS 
unit. If you have not already done so, connect the 
GPS unit to the computer via the USB cable and 
turn the unit on. Once your unit is correctly 
connected, you should see a check mark next to 
your unit in the Protocol list.  
 
To transfer data, go to the GPS dropdown menu. Choose Route > Receive. A 
“Transfer Complete” message box will appear on your GPS unit. Transfer your 
waypoints and tracks the same way. 
 
To see your waypoints, click on Waypoints in the menu bar. Click on “Show 
current…” Select a waypoint from the window that pops up and click “GoTo.”  
Your waypoints should show up as green dots.  
 
To print from USAPhotoMaps, select File > Print. A message will appear 
reminding you to set your printer preferences to Landscape Orientation (you will not 
be able to print without changing to landscape). Everything showing on the map 
(routes, waypoints, etc.) should show up in the printout.  
 
Create a new waypoint by clicking anywhere on the map where you want the 
waypoint located. A window will come up which allows you to write a description or 
note (Comment) about the waypoint and give it a name.  
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Create a route by clicking Route > Create. An information window will appear; click 
OK. On the map, click where you want to start your route and a line will follow your 
cursor. Click where you want the next point to be, and the line will remain between 
those points. Continue in the same manner to create a complete route. To end the 
route, double click on what will be the last point of your route. A window will appear 
asking if you want to save your route. Select Yes. A window will come up allowing 
you to name and save your route as a text (.txt) file. Once saved, you can send the 
route to your GPS unit. 
 
To send a route to your GPS unit, in the menu bar, click on GPS > Route > Send. 
Select the route you created and click Open (see picture below). The route will now 
be on your GPS unit for you to navigate or map. 
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Field Experience with GPS: 
Verifying Coordinate Data Using 

USAPhotoMaps Software  
Prepared by: The Virginia Geospatial Extension Program  

 
Background: USAPhotoMaps requires that the user understand and know how to operate a 
GPS unit, and organize and collect field data associated with each GPS unit. This software 
enables users to download GPS WayPoints (or tracks) from their GPS receivers onto their 
computer, and to superimpose the collected data on top of aerial photographs. 
USAPhotoMaps prompts the user for a single WayPoint (for reference purposes). The 
software then “goes out” onto the Internet (i.e. Terraserver) finds the appropriate digital 
image associated with the user defined Waypoint, and downloads this digital photograph 
onto the user’s computer. The user can then superimpose collected WayPoints onto the 
image, or digitize new WayPoints on the image, and download them onto the GPS. The 
user should be aware of the limitations of USAPhotoMaps. This software only accesses 
aerial photography from Terraserver, which is primiarily an archive of USGS imagery. 
These aerial photographs are a bit dated (the majority of the photographs for Virginia date 
back to the mid 1990’s). None of Virginia’s high resolution BaseMapping Imagery 
(VBMP) is accessible through this software. 2. Collect GPS WayPoints, Tracks, etc. 
Head out into the field and have some fun. Refer to The Garmin Etrex Legend: An 
Introductory Handbook for Extension Agents or the Garmin Owner’s Manual... 3. 
Download the GPS Data onto a Digital Aerial Photographic Map This involves 2 steps: 
Step 1: “Initializing, downloading, and opening” the Digital Photographs; Step 2: 
Downloading your GPS points on top of a digital aerial photograph (this is what the 
software is all about!) This manual will walk you through the two steps listed above... 
Getting Started... Before you can actually get started using USAPhotoMaps, you need 
to do a few things... 1. Setup and Install USAPhotoMaps software a. Install 
USAPhotoMaps on your computer (http://www.jdmcox.com/) b. Reboot your computer 
(not always necessary, but it has made a difference before!). 

The Virginia Geospatial Extension Program  
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EasyGPS – Short Tutorial 
 
EasyGPS is a free, downloadable program from TopoGrafix, and can be found at 
www.easygps.com. EasyGPS is a quick and easy way to transfer waypoints, routes, 
and tracks between your computer and GPS unit. EasyGPS lists all of your 
waypoints on the left side of the screen, and shows a plot of your GPS data on the 
right. EasyGPS can be used to back up and organize your GPS data. 
 
Setting up EasyGPS 
Connecting your GPS unit 
From the toolbar, click on Edit>Preferences… In the My GPS Receivers tab, click 
Add GPS… if your receiver is not listed. Click Settings and select the connection 
type you are using (USB or COM for a serial port connection). 
 
Click on the Units of Measure tab and check to ensure that the units are set to your 
preference. Click the My Coordinates Format tab and choose the format you use for 
your GPS unit (usually, WGS 84). 
 
Transferring Data 
To receive data from your GPS unit, connect your unit, turn it 
on, and click on the Receive icon. A Receive from GPS 
window will appear. Check the box(es) for the data you would like to receive 
(Waypoints, Routes, Tracks). Also, ensure that your GPS unit is selected from the 
dropdown menu. Click OK, and once the data has been sent, a Transfer Complete 
message should appear on your GPS unit. Sending data from Easy GPS to your 
GPS unit works in the same manner. 
 
To send select waypoints to your GPS unit, hold down the Control key on your 
keyboard and click on each of the waypoints you wish to send, then right-click. 
Select Send Waypoints to GPS, and those waypoints will be sent. To select several 
waypoints that are adjacent to each other on the list, hold down the Shift key and 
click the first and last waypoints you’d like to include; those two and all points 
between will be highlighted. 
 
Waypoints show up in the left side of the screen. The Label (name), Type, and 
Symbol for each waypoint is displayed. Each of these can be changed by editing the 
waypoint(s). 
 
Waypoints and Routes 
To edit a waypoint, right-click on the waypoint listing and select Edit Waypoint from 
the menu that appears. Or, while the waypoint of interest is highlighted in the list, in 
the toolbar, select Edit>Edit and the Edit Waypoint window will appear. 
 
To create a waypoint: In the toolbar on the top of the screen, select Tools>New 
Waypoint, or, click on the Add icon. An Edit Waypoint window will open, allowing you 
to enter the appropriate information. 
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To delete a waypoint, right-click on the waypoint in the waypoint list or on the map 
(the select arrow cursor must be selected). 
 
To create a route, select the Route tool. Your cursor will become a 
small diamond, and when you hover over a waypoint, it becomes a 
larger circle with a + above it. Click on the waypoints in the order you want them in 
your route. When you are finished, right-click to stop the route. 
 
To delete a route, while the route or select tool is activated, right-click on the route 
and select Delete Route. Click Yes on the Confirm Delete window that appears. 
 
Zooming 
To zoom in, select the Zoom icon. Your cursor will become a 
magnifying glass with a + in the center. Click in the center of the 
space where you want to zoom. The zoom level shows up at the lower left hand 
corner of the map side of the screen. 
To zoom out, hold down the Alt key while using the zoom cursor. 
 
Saving Data 
You must save your information in EasyGPS before closing, or it will be lost. Click on 
the Save icon. If this is the first time you are saving this information, a Save As 
window will appear. Choose the folder in which you want to save your data, and type 
in the file name. Be descriptive, such as Smith Property March 12 2007. The file is 
saved as a GPS Exchange File (.gpx). This file format is not used with most other 
programs, so if you need to transfer data to another program such as ArcView, you 
are better off using a program like GPS Utility that can save as other file formats. 
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Using GPS with Google Earth 
 

Google Earth is a powerful free tool for visualizing geographic data and for browsing 
web content in a spatial interface.  Although it does not allow for the measurement of 
area or include topographic map images, using several free programs in concert can 
give you many of the features that you would otherwise have to pay for. 
 
What is Google Earth? 
Earth is a software program that displays satellite imagery from an online server 
overlaid on topographic data, creating a digital three-dimensional model of the planet 
Earth.  Earth has many features, including a flight simulator, three-dimensional 
structures, and the ability to view user-created content, but this tutorial will focus on 
the features most relevant to forest stewardship.   
A GPS data import tool was added to Google Earth 5.0, released in early 2009.  The 
interface supports only Magellan and Garmin brand GPS units.  Google Earth is 
available for free download from google.earth.com.  Google Earth Pro has several 
additional features like quicker access to the image server, higher resolution print 
quality, and the ability to measure area, and costs $400.  

      

 
Getting Started 
After downloading and installing the software, plug in your GPS unit and open Earth.  
Under the Tools menu, click “GPS.”  In the “GPS Import” box, select the appropriate 
brand name.  If you have a Magellan, select “serial” if you have a 9-pin connector 
cable, rather than a USB cable.  Otherwise, select “Explorist.”  If you do have a 
serial cable, make sure that the baud rate in the setup menu of the GPS unit is set to 
4800.  If you have a Garmin, make sure that you have installed the USB driver that 
came with your GPS unit.   
Select the data types you want to download.  Under Options, choose your drawing 
preferences.  Check “Draw icons at track and route points” if you want an icon to be 
displayed for every track/route point recorded by your GPS unit.  This may clutter 
your display.  Check “Draw lines for tracks and routes” to draw each GPS track and 
route as a solid line.  Check the “Adjust altitude to ground height” check box to 
adjust all recorded points to ground level.  This will ignore the altitude data stored 
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with the points and make sure that your data appears on the surface.  Now click 
“Import.” 
Your data will appear under “Temporary Places” in the Places sidebar on the left.  
Right click on the name and select “Save to My Places” so that it will still show up 
the next time you open Earth.  Click the plus signs next to the folders until you see a 
list of points.  Double-click one of them to fly to its location in the viewer. 
 
If your GPS unit is not supported 
The Earth GPS interface only supports Magellan and Garmin brand GPS units, and 
may not work with older models.  If your unit is of a different brand or is an older 
unsupported model, you can still import your GPS data using free software like 
EasyGPS, GPS Utility, or GPS TrackMaker, and then saving your data as a [gpx, 
kml, or kmz] file.   
Follow the instructions in this manual for importing data in one of these other 
programs, then under the File menu, select “Save As…”  In the drop-down “Save as 
type” menu, select “GPS Exchange File (gpx)” or “Google Earth (kml).”  Name the 
file something descriptive (e.g. “west woodlot”) and remember where you save it.   
Then in Google Earth, click “Open…” under the File menu. Find the file you just 
saved and click “Open.”  Your file will appear in the “Places” sidebar on the left 
under “Temporary Places.”  Right click the name and select “Save to My Places” so 
that it will still show up the next time you open Earth. 
 
Navigating Earth 
There are several controls for navigating through the viewer.  You can start by 
double-clicking on one of the places listed in the sidebar, or by searching for 
somewhere new.   
The easiest way to move around an area is the pan tool.  Simply grab the image by 
left-clicking and then drag in the direction you want to move the image. Letting go of 
the mouse button while continuing to move the mouse will ‘throw’ the image, making 
the pan continue until you click the image again.   
Zoom in or out by using either your mouse wheel, by double-clicking on the image, 
by right-clicking and dragging, or by sliding the zoom scale on the right side of the 
screen.  The default view is from directly above, but if you want to see the 
topography of a location, you need to tilt the view.  You can do this by holding down 
the mouse wheel and dragging, or by using the compass icon in the top right corner 
of the screen.   
 
Viewing historical imagery 
You can view historical imagery to see how a property has changed over time.  Click 
the clock icon in the toolbar to show the time slider.  Each tick on the slider bar 
represents a different image.  The number, quality, and age of the available images 
varies greatly from place to place.   
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Measuring distances 
You can measure distances in Earth by clicking the ruler tool in the toolbar.  The line 
tab only allows one segment at a time, but allows tells you the heading of the line, 
while the path tab gives you the total distance of many segments.  Google Earth Pro 
also has tools for measuring the area of polygons and circles. 

 
 
 
 
Creating shapes 
You can create points, polygons, and lines to mark the corners and boundaries of 
property, stands, and management units and to keep notes on each.  Click one of 
the shape tools in the toolbar. 

 
 
 
 
 
While the properties window is displayed, draw the point, line, or polygon where you 
want it to appear on the map.  You can move the properties window partly off the 
screen if it is in the way.  Click and drag to create a curvy line, or click once on each 
corner for simple straight lines.  You can add text and change the colors and other 
properties under the tabs at the top of the properties box.  When you’re done editing, 
click the OK button.  To edit the shape or properties again later, right click on the 
shape’s name in the Places panel and select “Properties.” 
 
Exporting data 
Earth does not have a GPS data export function.  In order to upload data that you 
have created or modified in Earth onto your GPS unit, you must first save it and then 
upload it using another data management software program like EasyGPS, GPS 
TrackMaker, or GPS Utility.   
To save data, right click on the name in the Places panel of the sidebar and select 
“Save Place As…”  Choose a file name and file type.  The [kml] file type is accepted 
by more software programs, while the [kmz] file type is compressed and can also 
store pictures.  Open the data management software of your choice, select “Open…” 
under the file menu, and choose the file you just saved.  Now you can upload it to 
your GPS unit as you normally would. 
 
More information 
Download Google Earth and explore its many other features of at earth.google.com.  
Visit earth.google.com/userguide/v4/ for an in-depth instruction manual. 
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Common GPS Terms 
 
Accuracy – A measure of how close an estimate of a GPS position is to the true 
location. 
 
Azimuth – The compass direction from a position to a destination expressed as an 
angular measure from north and measured clockwise. Most commonly expressed as 00 
– 3600 degrees measured clockwise. GPS units use azimuth to express direction.  
 
Bearing – The compass direction expressed as a measurement from a given quadrant, 
such as North 360 East. The angular measure (36 in this case) will reference the acute 
(less than 90) angel from the North or South meridian as measured to the East or West. 
Bearings will need to converted to azimuth for use in the GPS unit. 
 
Coordinate Systems – Such as latitude/longitude, represent your position on the earth 
to a flat surface like a sale map. 
 
Course – The compass direction you are trying to follow from your starting point to the 
point you are trying to reach. 
 
Course Over Ground – see Track 
 
Declination Setting - GPS units can be adjusted to the amount of magnetic declination 
in the area of use.  
 
Differential GPS (DGPS) - An extension of the GPS system that uses land-based radio 
beacons to transmit position corrections to GPS receivers. DGPS reduces the effect of 
selective availability, propagation delay, etc. and can improve position accuracy to better 
than 10 meters. 
 
Direction – The direction between two locations is usually called a bearing, azimuth, or 
course. 
 
Error – Measurement of horizontal position error in feet or meters based on a variety of 
factors including Dilution of Precision (DOP) and satellite signal quality. 
 
GOTO – The selected point you wish to travel to or find. It may be a position fix or part of 
a route or track. 
 
Heading - The direction in which you or your vehicle are moving. For boat or airplane 
operations, this may differ from actual Course Over Ground (COG) due to winds, 
currents, etc. 
 
Latitude - A position's distance north or south of the equator, measured by degrees from 
zero to 90. One minute of latitude equals one nautical mile. 
 
Location – The actual physical place you occupy. The difference between a position fix 
and location is that a location is where you really are and a position fix is where a GPS 
unit says you are. 
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Longitude - The distance east or west of the prime meridian (measured in degrees). 
The prime meridian runs from the North Pole to the South Pole, through Greenwich, 
England. 
 
Magnetic Declination – The difference between true north and magnetic north at a 
specific location. 
 
Navigation - The act of determining the course or heading of movement. This 
movement could be for a plane, ship, automobile, person on foot, or any other similar 
means. 
 
NAVSTAR - The official U.S. Government name given to the GPS satellite system. 
NAVSTAR is an acronym for Navigation Satellite Timing and Ranging. 
 
Position fix - The GPS receiver's computed position coordinates. 
 
Precision – Measure of the “repeatability” of the data. Taking repeated readings from a 
point will improve the precision of the sample mean. 
 
Route - A group of waypoints entered into the GPS receiver in the sequence you desire 
to navigate them. 
 
Track - Your current direction of travel relative to a ground position (same as Course 
Over Ground). 
 
Trilateration – Mathmatical technique used by GPS navigators to determine user 
position, speed and elevation. The GPS unit constantly receives and analyzes radio 
signals from GPS satellites, calculating precise distance to each satellite. Four satellites 
are generally needed to determine an accurate elevation and distance. 
 
Waypoint/Landmark - Waypoints are locations or landmarks worth recording and 
storing in your GPS. These are locations you may later want to return to or avoid. They 
may be check points on a route or significant ground features such as a campsite, the 
truck, a cultural resource, or a favorite fishing spot). Waypoints may be defined and 
stored in the unit manually by taking coordinates for the waypoint from a map or other 
reference. This can be done before ever leaving home. Or more usually, waypoints may 
be entered directly by taking a reading with the unit at the location itself, giving it a name, 
and then saving the point.  
 
Wide Area Augmentation System (WAAS) - A system of satellites and ground stations 
operated by the Federal Aviation Authority that provide GPS signal corrections for better 
position accuracy for airplanes. WAAS consists of approximately 25 ground reference 
stations positioned across the United States that monitor GPS satellite data. Two master 
stations, located on either coast, collect data from the reference stations and create a 
GPS correction message. A WAAS-capable receiver can be adapted to ground use and 
give you a position accuracy of better than three meters, 95 percent of the time. It is only 
accessible if you are in the open, not in forest cover. 

 
 

Definitions courtesy of Garmin International, Inc. 
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GPS Hardware and Software Resource List 
 
Software 
Terrain Navigator by Maptech: www.maptech.com 
Cost: $99.95 per state.  
Features: USGS topographic maps; 2-D and 3-D maps; upload and download 
routes, tracks, and waypoints; shows profiles of elevation over a route; 
personalize, then print maps showing your routes and waypoints. By purchasing 
Terrain Navigator Pro, you can access aerial photographs. 
 
Mapsource TOPO USA 2008 DVD by Garmin: http://gpsnow.com/gmms.htm  
Cost: $80 - $120, depending on program 
Features: view color maps; create waypoints, routes, and tracks, and transfer 
them between your GPS unit and computer. Send detailed maps from the 
computer to your GPS unit for maps that show minor roads and points of interest. 
 
Expert GPS: www.expertgps.com 
Cost: $59.95 
Features: exchange data with Excel, Topo, Terrain Navigator and others; 
connects your GPS to internet mapping and information sites giving access to 
street maps, weather forecasts, and attractions. 
 
Topo USA 6.0 National by DeLorme: delorme.com 
Cost: $99.95 
Features: 2-D and 3-D maps, profiles show elevation gains between points, draw 
on maps, measure linear distances, embed photos and URLs to maps, link digital 
photos to a GPS log to show where the picture was taken. 
 
USAPhotoMaps by JDMCox Software: www.jdmcox.com   
Cost: free 
Features: downloads USGS aerial photo and topographical map data from 
Microsoft's free TerraServer Web site, saves it on your hard drive, and creates 
maps with GPS accuracy. You can go to any address, landmark, etc. and view its 
photo or topographical map. Add waypoints, routes, and text; transfer to and from 
your GPS unit. 
 
Easy GPS: www.easygps.com 
Cost: free 
Features: upload and download routes and waypoints, create routes. This 
program is very basic, but very easy to use. You can change waypoint symbols, 
view and print simple maps of your routes and waypoints, and enter new 
coordinates. It does not show maps or terrain features. 
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GPS Utility: www.gpsu.co.uk  
Freeware cost: free 
Shareware cost: $60 
Features: transfer data to/from a GPS receiver and store the data in PC files in 
one of several text formats. The program converts between different map datums 
and many coordinate formats. Route and track statistics are available and can be 
transferred into other programs for analysis (i.e. spreadsheet programs). The 
freeware version is limited to 100 waypoints, 500 trackpoints, and 5 routes, while 
the shareware version has a capacity of 65,000 waypoints or 500,000 trackpoints 
and provides a number of advanced facilities. 

 
GPS TrackMaker: www.gpstm.com 
Freeware cost: free 
Professional: $89 
Features: Most complete free program for GPS devices. Compatible with more than 
160 GPS models: support for Garmin, Magellan and others. Easily create your own 
maps, support for vector maps and images, and full integration with Google Maps® 
and Google Earth®. Vehicle Tracking and AVL. Completely free. No Adware or 
Spyware. 
 
Google Earth: http://earth.google.com  
Cost: free 
Features: lets you fly anywhere on Earth to view current color satellite imagery, 
maps, terrain, and 3D buildings. You type in an address and the program will 
take you to that location. You can download GPS points onto google earth maps 
from a GPS unit. You can also create waypoints on google earth maps that can 
be saved as a file (*.kml or *.kmz) and then transferred to GPSUtility and then 
uploaded to the GPS unit. 
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Web-Based Resources 
 
Information about GPS 
 
http://gps.faa.gov/gpsbasics/index.htm 
Information from the FAA about GPS basics, how WAAS works, and much more. 
 
http://pnt.gov/101  
Information about GPS, national and international augmentation systems, and 
links to other government-based GPS resources from the National Space-Based 
Positioning, Navigation, and Timing (PNT) Executive Committee. 
 
 
Mapping/GIS Resources 
 
www.mdmerlin.net  
Create free custom maps of locations in Maryland showing property lines, 
wetlands, roads, aerial photos, and more. 
 
http://seamless.usgs.gov 
U.S. Geological Survey (USGS) and the EROS Data Center (EDC) provide 
geospatial data through The National Map. View and download many geospatial 
data layers, such as National Elevation Dataset, National Land Cover Dataset, 
high resolution orthoimagery, and hydrography. 
 
http://sdatcert3.resiusa.org/rp_rewrite  
The Maryland Department of Assessments and Taxation Real Property Data 
Search offers information on property sales and ownership. 
 
http://websoilsurvey.nrcs.usda.gov/app  
Web soil surveys provide soil data via overlays on aerial photos. 
 
 
Additional Resources 
 
www.naturalresources.umd.edu/GPS.cfm 
The beginner and advanced GPS training materials from Maryland Cooperative 
Extension are available online, along with links to software programs and 
materials from other sources. 
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